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Material appearance

I Light is what you sense.

I Matter is what you see.

I Geometry is an abstraction over the shapes that you see.

I Appearance is a combination of the three.

↓

Reflectance: surface and subsurface scattering of light
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[Frisvad et al. 2007; Frisvad 2011;
Luongo et al. 2017; Frisvad 2018]

[Frisvad et al. 2012;
Frisvad et al. 2014;
Andersen et al. 2016;
Dal Corso et al. 2016;
Stets et al. 2017]
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Optical properties at multiple scales

microscopic scale

incident wave

scattered wave

microfacets

subsurface 
particles

nanoscopic scale

translucent object

macroscopic scale

BRDF

BSSRDF

or

I Appearance matching: manual adjustment of optical properties is nearly impossible.

I We can render objects with a plausible appearance but have a hard time matching the
appearance of a manufactured item to that of its digital twin.

I Research challenge: digital representations of real translucent objects.

I Important aspects: validation (photo-render alignment),
acquisition (inverse rendering), application (quality control).



Measuring surface microgeometry
• Alicona Infinite Focus

• Non-contact
• Optical
• Depth by focus-variation
• Vertical resolution depending on 

choice of magnification
• From x2.5: 2300 nm 
• Down to x100: 10 nm

• Min. measurable roughness:
• Sa: 3.5 down to 0.015

(arithmetic average height)
• Output: xxx.al3d file



Inspecting and correcting the data
• Free tool for analysis of height fields obtained by microscopy

Gwyddion: http://gwyddion.net/
• File→Open... (it opens .al3d files)
• Data inspection: Tools – Read horizontal and/or vertical profiles

Mode: cross / horizontal / vertical (click the image to extract a profile)
• Data correction (outlier removal and adjustment of base):

• Data Process→Correct Data→Mask of Outliers
Data Process→Correct Data→Remove Data Under Mask
Data Process→Mask→Remove Mask

• Data Process→Level→Flatten Base

• Process: Remove outliers, flatten base, remove outliers
• File→Save as... (store processed data as a .gwy file)

http://gwyddion.net/


Profilometry and data export
• Cutout: Use the Crop data tool with Create new image checked
• Roughness measurement along a line:

Use the Calculate roughness parameters tool
• Surface roughness: Use the Statistical quantities tool
• Export using File→Save as...

Choose an image file type (.png, for example)
Remove decorations (Value scale, Lateral scale, frame, etc.)

Note the physical width of the image
and the physical depth that the grayscale
values correspond to. These are available 
from the Statistical Quantities tool.



Height map to mesh by displacement mapping
• We can use Blender for this task https://www.blender.org/
• Following a tutorial https://johnflower.org/tutorial/make-mountains-blender-heightmaps

• Open Blender and delete the default cube (press del)
• Add→Mesh→Grid (increase X Subdivisions and Y Subdivisions in Add Grid)
• Import the height map as a texture
• Apply texture to grid as a displacement map
• Set Strength to physical depth divided by physical width
• Set shading to smooth (right click and select Shade Smooth)
• File→Export→Wavefront (.obj)  [you can uncheck Include UVs]
• This produces xxx.obj and xxx.mtl
• Edit xxx.mtl (set illum 4 and Ni 1.5)
• Ni is the assumed index of refraction

https://www.blender.org/
https://johnflower.org/tutorial/make-mountains-blender-heightmaps


What is a mesh?
• Surface geometry is often modeled by a 

collection of triangles, where some of them 
share edges (a triangle mesh).

• Triangles provide a discrete representation of 
an arbitrary surface. See teapot example.

• The indexed face set is a popular data 
representation of polygon meshes.

• Any polygon mesh can be converted to a 
triangle mesh.

• A .obj file contains indexed face sets.

Figure from Bærentzen et al. Guide to Computational Geometry Processing, Springer, 2012.



What is then a smooth mesh?

• Triangles are flat. Their geometric normals lead to flat shading.
• How do we make the object smooth? Interpolated per-vertex lighting?
• What is the normal in a vertex?

The angle-weighted pseudo-normal is a good choice.

• Another indexed face set is created for the vertex normals.
• Interpolation of the vertex normals across each triangle leads to smooth 

shading.
• The interpolated normal is

called the shading normal.

𝑛𝑛 =
∑𝛼𝛼𝑖𝑖𝑛𝑛𝑖𝑖
∑𝛼𝛼𝑖𝑖𝑛𝑛𝑖𝑖



Linear interpolation across triangles
• A point 𝒙𝒙 in a triangle is given by a weighted average of the triangle vertices

(𝒒𝒒1,𝒒𝒒2,𝒒𝒒3):

• The weights (𝛼𝛼,𝛽𝛽, 𝛾𝛾) are the barycentric coordinates.
• The point is in the triangle if 𝛼𝛼,𝛽𝛽, 𝛾𝛾 ∈ [0; 1]. That is,

• Replace the triangle vertices (𝒒𝒒1,𝒒𝒒2,𝒒𝒒3) by vertex normals and normalize to get 
the interpolated normal.

x 

q1

q2

q3

𝒙𝒙 = 𝛼𝛼𝒒𝒒1 + 𝛽𝛽𝒒𝒒2 + 𝛾𝛾𝒒𝒒3 , 𝛼𝛼 + 𝛽𝛽 + 𝛾𝛾 = 1

𝛼𝛼 ≥ 0 and 𝛽𝛽 ≥ 0 and 𝛼𝛼 + 𝛽𝛽 ≤ 1



Ray-triangle intersection
• Ray: 𝒓𝒓 𝑡𝑡 = 𝒐𝒐 + 𝑡𝑡𝜔𝜔, 𝑡𝑡 ∈ [𝑡𝑡min, 𝑡𝑡max]
• Triangle: 𝒗𝒗0,𝒗𝒗1,𝒗𝒗2
• Edges and geometric normal:

• Barycentric coordinates:

• The ray intersects the triangle’s plane at 𝑡𝑡′ = 𝒗𝒗0−𝒐𝒐 ⋅𝒏𝒏
𝜔𝜔⋅𝒏𝒏

• Find 𝒓𝒓 𝑡𝑡′ − 𝒗𝒗0 and decompose it into portions along the edges 𝒆𝒆0 and 𝒆𝒆1 to get 
𝛽𝛽 and 𝛾𝛾. Then check

v0

v1

v2

r 

o
ω

t
e0

e1

𝒆𝒆0 = 𝒗𝒗1 − 𝒗𝒗0,𝒆𝒆1 = 𝒗𝒗0 − 𝒗𝒗2,𝒏𝒏 = 𝒆𝒆0 × 𝒆𝒆1

𝒓𝒓 𝛼𝛼,𝛽𝛽, 𝛾𝛾 = 𝛼𝛼𝒗𝒗0 + 𝛽𝛽𝒗𝒗1 + 𝛾𝛾𝒗𝒗2 = 𝒗𝒗0 + 𝛽𝛽𝒆𝒆0 − 𝛾𝛾𝒆𝒆1

𝛼𝛼 ≥ 0 and 𝛽𝛽 ≥ 0 and 𝛼𝛼 + 𝛽𝛽 ≤ 1



Spatial subdivision
• To model arbitrary geometry with triangles, we need many triangles.
• A million triangles and a million pixels are common numbers.
• Testing all triangles for all pixels requires 1012 ray-triangle intersection tests.
• If we do a million tests per millisecond, it still takes more than 15 minutes.
• This is prohibitive. We need to find the relevant triangles.
• Spatial data structures offer logarithmic

complexity instead of linear.
• A million tests become twenty operations

• 15 minutes become 20 milliseconds.

Gargoyle embedded in oct tree [Hughes et al. 2014]

log2 106 ≈ 20



Treelet restructuring bounding volume hierarchy

• Practical GPU-based bounding volume hierarchy (BVH) builder.
1. Build a low-quality BVH (parallel linear BVH).
2. Optimize node topology by parallel treelet restructuring

(keeping leaves and their subtrees intact).
3. Post-process for fast traversal.

Reference:
Karras, T., and Aila, T. Fast parallel construction of high-quality bounding volume hierarchies. In Proceedings of HPG 2013, pp. 89-99. ACM, July 2013.

treelet reorganized
treelet



NVIDIA OptiX https://developer.nvidia.com/optix

• Interactive ray tracing demos: cow (sample 6), glass, PPM, PT, Cook.

Reference:
Parker, S. G., Bigler, J., Dietrich, A., Friedrich, H., Hoberock, J., Luebke, D., McAllister, D., McGuire, M., Morley, K., Robison, A., and Stich, M. OptiX: a 
general purpose ray tracing engine. ACM Transactions on Graphics (SIGGRAPH 2010) 29(4):66, July 2010.

https://developer.nvidia.com/optix


Two meshes – how to combine?



Multiscale modeling of surface geometry
• Smallest scale: everything is quantum particles. Matter is 

electrons going from place to place (ignore nuclei).
Light-matter interaction: A photon interacts with an electron.

• Microscopic scale: surfaces but no roughness. All details are 
defined.
Light-matter interaction: interaction of electromagnetic waves 
with surfaces.

• Macroscopic scale: objects with a macrosurface and material 
specification (roughness/absorption) mapped onto them.
Light-matter interaction: bidirectional (scattering) distribution 
functions for rays of light.
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ω’
ω

glossy BRDF f (x, , )r ω’ω



Simulation to go from micro to macro
• Take the plane wave solution for Maxwell’s equations.
• The (complex) index of refraction 𝑛𝑛 is a quantity summarizing the microscopic

material properties (permittivity, permeability, conductivity).
• Consider an electromagnetic plane wave incident on a surface between two half-

space media (of refractive indices 𝑛𝑛𝑖𝑖 and 𝑛𝑛𝑡𝑡).
• By requiring continuity across the interface, we can derive:

• The law of reflection (direction of reflected light)
• The law of refraction (direction of transmitted light)
• Fresnel’s equations for reflection (amount of reflection vs. transmitted light)

• Neglecting wavelength (assume 𝜆𝜆 → 0), we can trace rays along the direction of
energy propagation in the waves (along Poynting’s vector).

• Given surface microgeometry, we can use such ray tracing to compute
bidirectional scattering distribution functions (BSDFs).



Ray tracing specular surfaces
• Fresnel’s equations for reflection (𝑅𝑅 is reflected, 𝑇𝑇 = 1 − 𝑅𝑅 is transmitted)

�̃�𝑟⊥ =
𝑛𝑛𝑖𝑖 cos 𝜃𝜃𝑖𝑖 − 𝑛𝑛𝑡𝑡 cos 𝜃𝜃𝑡𝑡
𝑛𝑛𝑖𝑖 cos 𝜃𝜃𝑖𝑖 + 𝑛𝑛𝑡𝑡 cos 𝜃𝜃𝑡𝑡

, �̃�𝑟∥ =
𝑛𝑛𝑡𝑡 cos 𝜃𝜃𝑖𝑖 − 𝑛𝑛𝑖𝑖 cos 𝜃𝜃𝑡𝑡
𝑛𝑛𝑡𝑡 cos 𝜃𝜃𝑖𝑖 + 𝑛𝑛𝑖𝑖 cos 𝜃𝜃𝑡𝑡

, 𝑅𝑅 =
1
2

�̃�𝑟⊥ 2 + �̃�𝑟∥
2

• The law of refraction

𝑛𝑛𝑡𝑡 sin𝜃𝜃𝑡𝑡 = 𝑛𝑛𝑖𝑖 sin𝜃𝜃𝑖𝑖 ⇒ cos𝜃𝜃𝑡𝑡 = 1 −
𝑛𝑛𝑖𝑖
𝑛𝑛𝑡𝑡

2

sin2 𝜃𝜃𝑖𝑖

• Directions of reflected and refracted light

𝜔𝜔𝑠𝑠 = 2 𝜔𝜔𝑖𝑖 ⋅ 𝑛𝑛 𝑛𝑛 − 𝜔𝜔𝑖𝑖

𝜔𝜔𝑡𝑡 =
𝑛𝑛𝑖𝑖
𝑛𝑛𝑡𝑡

𝜔𝜔𝑖𝑖 ⋅ 𝑛𝑛 𝑛𝑛 − 𝜔𝜔𝑖𝑖 − 𝑛𝑛 cos𝜃𝜃𝑡𝑡



Macro and micro surface

m

• The BSDF defines the ratio of 
light incident in a surface point 𝒙𝒙
from a direction 𝜔𝜔′ that scatters 
into another direction 𝜔𝜔.

• The BRDF 𝑓𝑓𝑟𝑟 is the reflectance 
part of the BSDF.
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x

ω’
ω

glossy BRDF f (x, , )r ω’ω

The microsurface defines the geometry of 
the differential area d𝐴𝐴 at the position 𝒙𝒙
on the macrosurface.



Bidirectional Reflectance Distribution Function
• The definition of the BRDF: 𝑓𝑓𝑟𝑟 𝒙𝒙,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑟𝑟 = d𝐿𝐿𝑟𝑟(𝒙𝒙, 𝜔𝜔𝑟𝑟)

d𝐸𝐸(𝒙𝒙, 𝜔𝜔𝑖𝑖)

The ratio of an element of reflected radiance d𝐿𝐿𝑟𝑟 to an element of irradiance d𝐸𝐸.

• An element of irradiance due to incident radiance within a differential element 
of solid angle d𝜔𝜔𝑖𝑖:

d𝐸𝐸 𝒙𝒙,𝜔𝜔𝑖𝑖 = 𝐿𝐿𝑖𝑖 𝒙𝒙,𝜔𝜔𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖 , 𝐿𝐿𝑟𝑟 = �
2𝜋𝜋
𝑓𝑓𝑟𝑟 𝐿𝐿𝑖𝑖 cos 𝜃𝜃𝑖𝑖 d𝜔𝜔𝑖𝑖

• Radiance is radiant flux per projected area per solid angle:

𝐿𝐿 =
d2Φ

cos 𝜃𝜃 d𝐴𝐴 𝑑𝑑𝜔𝜔
, Φ𝑟𝑟 = �

𝐴𝐴
�
Ωr
𝐿𝐿𝑟𝑟 cos 𝜃𝜃𝑟𝑟 d𝜔𝜔r d𝐴𝐴

• Radiant flux Φ is a measurable quantity. So, we can set up a measurement 
equation for reflected radiant flux Φ𝑟𝑟, where 𝐴𝐴 is the microsurface. 

• We can then evaluate a BRDF by solving the measurement equation.

n1

n2

Ωr



Noise
• Noise explorer: 

https://people.compute.dtu.dk/jerf/code/noise/

• Sparse convolution noise
• Convolution of randomly placed (𝒙𝒙𝑖𝑖,𝑗𝑗) 

impulses of random value (𝛼𝛼𝑖𝑖,𝑗𝑗).
• Use a filter kernel with compact support 

and insert a regular grid (cell vertices 𝒒𝒒𝑖𝑖).

cubic 𝒗𝒗 = � 1 − 4 𝒗𝒗 ⋅ 𝒗𝒗 3 for 𝑣𝑣 ⋅ 𝑣𝑣 <
1
4

0 otherwise
• Use a seeded RNG: rnd(𝑡𝑡)
• Choose a number of impulses per cell (𝑁𝑁).

noise 𝒑𝒑 =
4

53 𝑁𝑁
�
𝑖𝑖=0

7

�
𝑗𝑗=1

𝑁𝑁

𝛼𝛼𝑖𝑖,𝑗𝑗 cubic(𝒙𝒙𝑖𝑖,𝑗𝑗 − 𝒑𝒑)

𝒙𝒙𝑖𝑖,𝑗𝑗 = 𝒒𝒒𝑖𝑖 + 𝝃𝝃𝑖𝑖,𝑗𝑗
𝛼𝛼𝑖𝑖,𝑗𝑗 = rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗 1 − 2 𝑗𝑗 mod 2

𝝃𝝃𝑖𝑖,𝑗𝑗 = rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+1 , rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+2 , rnd 𝑡𝑡𝑛𝑛𝑖𝑖,𝑗𝑗+3
𝑛𝑛𝑖𝑖,𝑗𝑗 = 4 𝑁𝑁𝒒𝒒𝑖𝑖 ⋅ 𝒂𝒂 + 𝑗𝑗

𝒒𝒒𝑖𝑖 = 𝒑𝒑 −
1
2

,
1
2

,
1
2

+ 𝑖𝑖 mod 2,
𝑖𝑖
2

mod 2,
𝑖𝑖
4

mod 2

My choice: 𝑁𝑁 = 30 and 𝒂𝒂 = (1, 1000, 576)

0.5 𝐴𝐴 noise 𝐵𝐵 𝒑𝒑 + 1
𝐴𝐴 = 1,𝐵𝐵 = 1

https://people.compute.dtu.dk/jerf/code/noise/


Noise-based modeling
• Noise with octaves

• Number of octaves Ω ≥ 1
• Lacunarity ℓ > 1
• Fractional increment (roughness) 𝐻𝐻 ∈ 0,1

fBm 𝒑𝒑 = �
𝑖𝑖=0

Ω−1

ℓ−𝐻𝐻𝑖𝑖noise(𝒑𝒑 ℓ𝑖𝑖)

• 𝐻𝐻 = 1 is a monofractal
(same fractal dimension everywhere)

• Absolute value for sharp edges

turbulence 𝒑𝒑 = �
𝑖𝑖=Ωlow

Ωhigh
1
2𝑖𝑖

noise(2𝑖𝑖 𝒑𝒑)

Top rows: input from marble images

Kim Harder Fog. Noise-based texture synthesis by analysis of image examples.
MSc thesis, Technical University of Denmark, 2017.

Bottom rows: fBm fit



Line integral convolution
• Given a 3D noise function like sparse convolution noise:

• For each pixel take the integral along a line.

• Obtain a tangent space of
your 3D surface to be printed.
https://people.compute.dtu.dk/jerf/code/hairy/

+

References:
- Battke, H., Stalling, D., Hege H.-C. Fast line integral convolution for arbitrary surfaces in 3D. In Visualization and Mathematics, pp. 181-195. Springer, 1997.
- Frisvad, J. R. Building an orthonormal basis from a 3d unit vector without normalization. Journal of Graphics Tools 16(3):151-159, August 2012.

https://people.compute.dtu.dk/jerf/code/hairy/
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Appearance printing

Actuators
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appearance control through 3D printing



BRDF printing and 3D printer ground noise

ground 𝒑𝒑 =
2
3

noise
𝒑𝒑

50 𝜇𝜇𝜇𝜇
+

1
9

noise
𝒑𝒑

25 𝜇𝜇𝜇𝜇
+

1
12

noise
𝒑𝒑

2 𝜇𝜇𝜇𝜇



Anisotropic smileys (ridges and sinusoids)

Top row: 3D printed
Middle row: computed
Bottom row: direction of incidenceInput texture and microscope images.
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Digital
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Digital PrototypeRendering & 
SimulationModel

Particles:
Refractive index,
concentration, size
distribution, density

Host medium:
Refractive index,
density, viscosity, 
surface tension Global parameters:

temperature, gravity,
pressure

ingredients products

Building models using 
particle composition 
and Lorenz-Mie theory

algae in sea ice

[Frisvad et al. 2007a]

[Frisvad 2008]

milk: water, vitamins, protein and fat particles



Light-material interaction in a volume

I Some light is absorbed.

I Some light scatters away (out-scattering).

I Some light scatters back into the line of sight (in-scattering).

(absorption + out-scattering = extinction)

I Historical origins:

Bouguer [1729, 1760] A measure of light. Exponential extinction.
Lambert [1760] Cosine law of perfectly diffuse reflection and emission.
Lommel [1887] Testing Lambert’s cosine law for scattering volumes.

Describing isotropic in-scattering mathematically.
Chwolson [1889] A theory for subsurface light diffusion (similar to Lommel’s).
Schuster [1905] Scattering in foggy atmospheres (plane-parallel media).

Reinventing the theory in astrophysics.
King [1913] General equation which includes anisotropic scattering (phase function).

Chandrasekhar [1950] The first definitive text on radiative transfer.



Radiative transfer and scattering properties

I We follow a ray of light passing through a scattering medium.
I The parameters describing the medium are

σa the absorption coefficient [m−1]
σs the scattering coefficient [m−1]
σt the extinction coefficient [m−1] (σt = σa + σs)
p the phase function [sr−1]
ε the emission properties [Wsr−1m−3] (radiance per meter).

I The radiative transfer equation (RTE)

(~ω · ∇)L(x , ~ω) = −σt(x)L(x , ~ω)

+ σs(x)

∫
4π

p(x , ~ω′, ~ω)L(x , ~ω′) dω′

+ ε(x , ~ω) ,

where L is radiance at the position x along the ray in the direction ~ω.



Computing appearance from scattering properties

I Prediction requires solving the radiative transfer equation:

(~ω · ∇)L(x , ~ω) = −σt(x)L(x , ~ω) + σs(x)

∫
4π
p(x , ~ω′, ~ω)L(x , ~ω′) dω′ + ε(x , ~ω) .

I The solution method of choice today:

Stochastic ray tracing (Monte Carlo integration).

light source

scattering material

scattering
event

radiance is traced along the rays

emerging light

observer

I How do we compute input scattering properties from the particle composition of a
material?



Scattering of a plane wave by a spherical particle
I A plane wave scattered by a spherical particle

gives rise to a spherical wave.

I The components of a spherical wave are
spherical functions.

I To evaluate these spherical functions, we use
spherical harmonic expansions.

I Coefficients in these spherical harmonic
expansions are referred to as Lorenz-Mie
coefficients an and bn.

n0

n
med

np

z

y

θ0

n

t
k0

ki

I Lorenz [1890] and Mie [1908] derived formal expressions for an and bn using the
spherical Bessel functions jn and yn.

I These expressions are written more compactly if we use the Riccati-Bessel
functions: ψn(z) = z jn(z) , ζn(z) = z(jn(z)− i yn(z)) ,
where z is (in general) a complex number.



The Lorenz-Mie coefficients (an and bn)
I Using the Riccati-Bessel functions ψn and ζn, the expressions for the Lorenz-Mie

coefficients are

an =
nmedψ

′
n(y)ψn(x)− npψn(y)ψ′

n(x)

nmedψ′
n(y)ζn(x)− npψn(y)ζ ′n(x)

bn =
npψ

′
n(y)ψn(x)− nmedψn(y)ψ′

n(x)

npψ′
n(y)ζn(x)− nmedψn(y)ζ ′n(x)

.

I Primes ′ denote derivative.
I nmed and np are the refractive indices of the host medium and the particle

respectively.
I x and y are called size parameters.

I If r is the particle radius and λ is the wavelength in vacuo, then x and y are
defined by

x =
2πrnmed

λ
, y =

2πrnp
λ

.



From particles to appearance

Courtesy of University of Guelph

Lorenz-Mie theory provides the link



Scattering by spherical particles
I The Lorenz-Mie theory:

p(θ) =
|S1(θ)|2 + |S2(θ)|2

2|k |2Cs

S1(θ) =
∞∑
n=1

2n + 1

n(n + 1)
(anπn(cos θ) + bnτn(cos θ))

S2(θ) =
∞∑
n=1

2n + 1

n(n + 1)
(anτn(cos θ) + bnπn(cos θ)) .

I an and bn are the Lorenz-Mie coefficients.

I πn and τn are spherical functions associated with the Legendre polynomials.

small particle large particle



Quantity of scattering
I Lorenz-Mie theory continued:

The scattering and extinction cross sections of a particle:

Cs =
λ2

2π|nmed|2
∞∑
n=1

(2n + 1)
(
|an|2 + |bn|2

)
Ct =

λ2

2π

∞∑
n=1

(2n + 1)Re

(
an + bn
nmed

2

)
.



Bulk optical properties of a material
I Input is the desired volume fraction of a component v and a representative

number density distribution N̂. We have

v̂ =
4π

3

∫ rmax

rmin

r3N̂(r) dr ,

and then the desired distribution is N = N̂v/v̂ .
I Use this to find the bulk properties σs (and σt likewise)

σs =

∫ rmax

rmin

Cs(r)N(r) dr .



Computing scattering properties

I Input needed for computing scattering properties:
I Particle composition (volume fractions, particle shapes).
I Refractive index for host medium nmed.
I Refractive index for each particle type np.
I Size distribution for each particle type (N).

I Lorenz-Mie theory uses a series expansion. How many terms should we include?

I Number of terms to sum M =
⌈
|x |+ p|x |1/3 + 1

⌉
.

I Empirically justified [Wiscombe 1980, Mackowski et al. 1990].
I Theoretically justified [Cachorro and Salcedo 1991].
I For a maximum error of 10−8, use p = 4.3.

I Code for evaluating the expansions in the Lorenz-Mie theory is available online
[Frisvad et al. 2007]: https://people.compute.dtu.dk/jerf/code/

https://people.compute.dtu.dk/jerf/code/


Particle contents (examples)
I Natural water

I Refractive index of host: saline water.
I Mineral and alga contents: user input in volume fractions.
I Refractive indices of mineral and algae: empirical formulae.
I Shape of mineral and algal particles: spheres.
I Size distributions: power laws.

I Icebergs
I Refractive index of host: pure ice.
I Brine and air contents: depend on temperature, salinity, and density.
I Refractive index of brine: empirical formula, measured absorption spectrum.
I Shape of brine pores and air pockets: closed cylinders and ellipsoids.
I Size distributions: power laws.

I Milk
I Refractive index of host: water + dissolved vitamin B2.
I Fat and protein contents: user input in wt.-%.
I Refractive index of milk fat and casein: measured spectra.
I Shape of fat globules and casein micelles: spheres and a volume to surface area ratio.
I Size distributions: log-normal with mean depending on fat content and homogenization

pressure.



Case study: natural waters

I Glacial melt water with rock flour mixing with purer water from melted snow to
give Lake Pukaki in New Zealand its beautiful bright blue colour.



Oceanic and coastal waters

Cold Atlantic Mediterranean

Baltic North Sea



Oceanic and coastal waters



Case study: icebergs



Ice sculptures

pure ice compacted snow white ice



Algal ice



Case study: milk

skimmed low fat whole

I Refractive index of host: water + dissolved vitamin B2.

I Fat and protein contents: user input in wt.-%.

I Refractive index of milk fat and casein: measured spectra.

I Shape of fat globules and casein micelles: spheres and a volume to surface area ratio.

I Size distributions: log-normal with mean depending on fat content and homogenization pressure.



Measurements used for the milk model
I Refractive indices:

400 500 600 700

1.35

1.4

1.45

1.5

 Scattering

wavelength (nm)

R
ef

ra
ct

iv
e 

in
de

x 
(r

ea
l p

ar
t)

water

milk fat

casein

400 500 600 700
0

1

2

3

4

x 10
−7  Absorption

wavelength (nm)

R
ef

ra
ct

iv
e 

in
de

x 
(im

ag
in

ar
y 

pa
rt

)

water
riboflavin

milk host

400 500 600 700
0

0.2

0.4

0.6

0.8

1

1.2
x 10

−5  Absorption

wavelength (nm)

R
ef

ra
ct

iv
e 

in
de

x 
(im

ag
in

ar
y 

pa
rt

)

milk fat

casein

I Particle size distributions:
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Predicting appearance based on a content declaration

water vitamin B2 protein fat skimmed low fat whole

I Vitamin B2 content: 0.17 mg / 100 g

I Protein content: 3 g / 100 g

I Fat content: 0.1 g (skimmed), 1.5 g (low fat), 3.5 g (whole) / 100 g

I Homogenization pressure: 0 MPa (model: [0, 50] MPa)



Predicting appearance

Scene

Light: Bowens BW3370 100W Unilite (6400K)

DLSR camera, 
50 mm lens

cloudy 
beverage

Backdrop: white cardboard

organic low fat milk

rendering photograph

I Digital scene modeled by hand to match physical scene (as best we could)



Case study: cloudy apple juice

The visual appearance of a cloudy drink is a decisive factor for consumer
acceptance. [Beveridge 2002]

Let us see if we can use Lorenz-Mie theory to
create an appearance model useful for:

I predicting the visual effect of modifying
production parameters;

I analyzing a given product with cameras.



Apple juice appearance model

I Host medium is water with
dissolved solids (mostly sugars).

I Particles are browned apple flesh.

I Optical properties given by
complex indices of refraction: n = n′ + i n′′.

I We can relate these refractive indices
to production parameters:
I Particle concentration.
I Storage time.
I Handling of apples.
I . . .



Apple juice appearance model
I We use a bimodal particle size distribution N̂

from Zimmer et al. [1994], scaled to the desired
volume concentration v of particles (N = N̂v/v̂).

Fine cloud
Coarse cloud

µ



Rendering
I We can neither use single scattering nor diffusion theory.
I Thus, we use progressive unidirectional path tracing (Monte Carlo).
I Accounting for refractive indices using different interfaces.



Results
I Varying particle

concentration v
(horizontally).

I Varying storage time
and handling
(vertically).
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Patch-based quantitative comparison

0.0 g/L 0.1 g/L 0.2 g/L 1.0 g/L0.5 g/L 2.0 g/L

4 days

9.5 days, peeled

9.5 days

27 days

Reference



Patch-based quantitative comparison

0.0 g/L 0.1 g/L 0.2 g/L 1.0 g/L0.5 g/L 2.0 g/L

4 days

9.5 days, peeled

9.5 days

27 days



Visual comparison - MAM 2016 rendering

rendering photograph



Visual comparison - EPJH 2019 rendering

rendering photograph



The input challenge

I Light transport simulation has come a long way, but
renderings can only be as realistic/accurate as the input parameters permit.

I How do we get plausible input parameters?
I Modeling (example: light scattering by particles).
I Measuring (example: diffuse reflectance spectroscopy).

I Suppose we would like to go beyond visual comparison.
I How do we assess the appearance produced by a given set of input parameters?

I Full digitization of a scene.
I Reference photographs from known camera positions.
I Pixelwise comparison of renderings with photographs.



Sensors

Actuators

Synthesis,
Prediction &

Modeling

Physical
World

Digital
Representation



Sensors

Physical
World

Digital
Representation



Simplistic model validation
I Camera
I Tripod
I Laser pointer
I Cup (use black cup)

Laser in skimmed milk - photo Laser in skimmed milk - computed
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Captured images used for 
estimating the reduced 
scattering coefficient:



Measuring scattering properties using diffuse reflectance spectroscopy

reduced scattering [1/cm] absorption [1/cm]

wavelength [nm] wavelength [nm]

extract profile
spectroscopy

Infer optical properties using an analytic subsurface scattering model

yogurt

milkoblique incidence 
reflectometry

super continuum light source 

AOTF

computer systemlaser delivery fiber
CCD

sample

lab setup in situ setup sample image
(log transformed, 

false colours)

I Proper version of the simplistic approach used for validation of the milk model.



Research examples
Acquiring input for appearance models
- Geometry from structured light and CT scans

[Eiriksson et al. 2016; Stets et al. 2017; Guerra et al. 2019]

- Reflectance properties from sparse sampling and PCA reconstruction
[Nielsen et al. 2015; Xu et al. 2016; Stets et al. 2017; Nielsen et al. 2017; Lyngby et al. 2019]

- Scattering properties from directional subsurface scattering
[Abildgaard et al. 2015; Abildgaard et al. 2016]

- Material properties from analysis-by-synthesis
[Dal Corso et al. 2016; Stets et al. 2017]

- Environment mapping
[Stets et al. 2017]

White 
cloth

Grey 
checker

White 
checker



Multimodal digitization pipeline

[pipeline video] [overview video]

I Data available at https://eco3d.compute.dtu.dk/pages/transparency

https://eco3d.compute.dtu.dk/videos/reassembly_pipeline.mp4
https://eco3d.compute.dtu.dk/videos/reassembly_pipeline.mp4
https://eco3d.compute.dtu.dk/videos/reassembly_gp.mp4
https://eco3d.compute.dtu.dk/pages/transparency


Analysis by synthesis
We can compare rendered images with photographs to estimate material parameters
(model fitting) or to find deviations from expected appearance:

Rendered images using different material appearance models. References.



Physical to digital material appearance.
Models: milk, juice, teeth, icebergs, rainbows, fur, glass

organic low fat milk

render photo

unfiltered apple juice

photorender

algae in sea ice

render photo

[Frisvad et al. 2005]

render photo

[Larsen et al. 2012]

[Andersen et al. 2016]

[Frisvad 2008]

[Dal Corso et al. 2016]
[Stets et al. 2017]

Research examples



Thank you for your attention

A. Luongo, V. Falster, M. B. Doest, M. M. Ribo, E. R. Eiriksson, D. B. Pedersen, and J. R. Frisvad. Microstructure 
control in 3D printing with digital light processing. Computer Graphics Forum, 2019. To appear.


	mat_app_mod_4
	Sider fra insurface
	mat_app_mod_4
	Sider fra insurface
	mat_app_mod_3
	mat_app_mod_2
	lego-made-presentation
	lego-made-presentation
	lego-made-presentation
	lego-made-presentation
	lego-made-presentation
	DTU_BxDiff_kickoff
	Research examples
	Research examples
	Dias nummer 10





	slides

	mat_app_mod
	insurface
	Material Appearance Modelling:�In-Surface and Subsurface Light Scattering
	Research examples
	Measuring surface microgeometry
	Inspecting and correcting the data
	Profilometry and data export
	What is a mesh?
	What is then a smooth mesh?
	Linear interpolation across triangles
	Ray-triangle intersection
	Spatial subdivision
	Treelet restructuring bounding volume hierarchy
	NVIDIA OptiX https://developer.nvidia.com/optix
	Two meshes – how to combine?
	Multiscale modeling of surface geometry
	Simulation to go from micro to macro
	Macro and micro surface
	Noise
	Noise-based modeling
	Line integral convolution
	BRDF printing and 3D printer ground noise
	Anisotropic smileys (ridges and sinusoids)
	Thank you for your attention



	analysis-by-synthesis



	analysis-by-synthesis



